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Creating a New Geographical Database

1. Choose New under the File menu, and choose a name for the new 
geographical database. 

2. Click on the Start button.

3. Using the left mouse button to click where the vertices of the polygon 
are, start drawing the exterior most polygon. The colour of the polygon
which you are working on is White.

4. When you approach the end of the polygon, click the right mouse 
button to complete the polygon. The completed polygon turns Red as 
the program calculates its area, and then it turns Green. If the polygon
remains red for an excessive period of time (depending on the speed of
the computer, and whether or not it has a co-processor), then most 
likely you have allowed two segments of the polygon to intersect, 
which will confuse the program. In this case, click on the Abort button 
and start over.

5. Start drawing a new polygon inside the green polygon. The program 
will not allow you to draw outside the green polygon. As before, use 
the left mouse button to draw the polygon, and the right mouse button
to complete it. When the polygon is completed, it turns red for a short 
while, and then green.

6. If you do not wish to continue drawing additional polygons within the 
innermost Green polygon, click the right mouse button again, 
whereupon the innermost green polygon turns Blue. Now you can 
continue drawing additional polygons within the next innermost Green
polygon, but not within the Blue polygon. In this way, you are able to 
create complex geographical structures.

7. When the outermost polygon turns blue after clicking on the right 
mouse button, the creation of the new geographical database is 
complete, and the program chooses a default colour scheme for the 
different regions. You may click on a region at this stage if you wish to 
change the colour or fill style of the region.



Setting the Scale

The scale is set by choosing the Set Scale item under the Design menu. 
This basically tells the program how to convert between screen coordinates 
and the actual coordinates of the geographical data. All densities and 
distances calculated by the program are calculated in terms of the real scale 
and the units which you choose here.

Click and hold the left mouse button down where you wish to start the line, 
and drag the line over to where you wish to stop. A small dialogue box pops 
onto the screen, in which you should enter the length of the line in the units 
you have in mind. For example, you could choose a line spanning the length 
of the entire geographical area, and you might decide that that line is 1000 
meters long. So you would enter 1000 in the dialogue box, and ALL 
subsequent distances would be in terms of meters, areas in square meters, 
radii of plants in meters, etc. If you wish the change the scale at any time in 
the program, then hit the Rescale button.

NOTE: you have to remember which unit of length you use, because all the 
program does is make sure that all dimensional data are in terms of this unit.
Choose a convenient unit, otherwise you may find yourself expressing the 
radii of plants in miles later in the program.



Setting Vegetation Densities

Select Vegetation under the Design menu to set the vegetation densities. 
To design the vegetation for a particular region, move the cursor over to that 
region use the left mouse button to click and bring up a dialogue box.

Press the Set Radius Distribution button. Then enter various radii, and 
frequencies corresponding to those radii. For example, if you enter

radius freq
      1     3
      2     1

(where the units are chosen when you set the scale), then there will be 
approximately three times as many plants of radius 1 than of radius 2. When 
the program actually generates the plants for that region, it uses a smooth 
probability distribution for the radius, using the above table.Once you have 
completed the table, the program automatically calculates the min, max and 
mean radius, and also plots the smooth probability density function which it 
will use the generate the radii. Absolute magnitudes of the frequencies are 
unimportant; relative values are important only

Next, fill in a number for the Number of Plants in Test Box, and hit the 
Test button. It may be easier to change the magnification. Choose the 
number of plants for the test box until you are satisfied with the density of 
the plants.



Setting Animal Densities

Select Critters under the Design menu to set the vegetation densities. To 
design the animal populations for a particular region, move the cursor over 
to that region use the left mouse button to click and bring up a dialogue box.

Press the Set Group Size Distribution button. Then enter various group 
sizes, and frequencies corresponding to those sizes. For example, if you 
enter

size freq
      3     3
      10     1

then there will be approximately three times as many groups of size 3 
animals than of size 10 animals. When the program actually generates the 
groups for that region, it uses a smooth probability distribution for the size, 
using the above table.Once you have completed the table, the program 
automatically calculates the min, max and mean group size, and also plots 
the smooth probability density function which it will use the generate the 
sizes. Absolute magnitudes of the frequencies are unimportant; relative 
values are important only

Groups of animals in this program are modelled by means of circles and 
ellipses. The animals within a group are distributed uniformly within a circle, 
the radius of which is entered as the Group Radius. Groups are kept apart 
by using a territorial ellipse. You can specify this territorial ellipse by giving a 
range for the first radius and the second radius, and the orientation of 
the ellipse. The radii and orientation of a given ellipse are chosen randomly 
from these ranges.

Next, fill in a number for the Number of Groups in Test Box, and hit the 
Test button. It may be easier to change the magnification. Choose the 
number of groups for the test box until you are satisfied with the density of 
the groups. Select the Show Ellipses option to see the ellipses which make 
sure that groups do not intersect.



Drawing Transects

Select Transects under the Design Menu. Press the Start button, and then 
the Add Transect button. Move the cursor to where you wish to start the 
transect, and click and hold the left mouse button, move the cursor to the 
end of the transect, and let go.

When the dialogue box pops up, enter in the half width of the transect, using 
the same units that you used for the scale. 

Press the Add Transect button if you wish to draw more transects.



Generating the Animals and Plants

The animals and plant distributions are generated by choosing the 
Vegetation and Groups option under the Generate menu. The vegetation 
and animals must be designed before they can be generated.

If the plants and groups had been generated in a previous simulation, then 
you can choose not to regenerate them, in which case the plants and groups 
for the regions will be read in from disk.

Note that you can turn off the displaying of groups and/or vegetation as you 
generate them. This is recommended for slow computers.



Doing the Count

Once the groups and plants have been generated, you can do either an 
aerial count, or a ground count. In either case, the procedure is the same. 
Select either ground count or aerial count from the Count menu. 

Then in the dialogue box which pops up, you can choose a stopping number 
for the Fourier series. The stopping number is the cutoff for the number of 
terms which are kept in the Fourier expansion used in the calculation of the 
densities. By default, the stopping rule as described in the Monograph is 
used; this automatically chooses which stopping number to use.

The other parameters which need to be specified are the sighting 
probabilities. For a description of what the sighting probabilities mean, look 
at the short description here which was in the printed manual provided with 
the first version.

Note that you can also use the built in Fourier analysis method to calculate 
densities from existing real data. Have a look at the release notes here which
were also provided with the first version.



Results of the Count

The results can be displayed for each transect, or you can select Total from 
the Current Strip list, which displays the results as if the stips were really 
all part of one single transect, placed end to end.

You can also display the sighting function g(x) to check on whether the 
fourier series method is behaving the way you would expect, particularly for 
the ground count. Have a look at the short review here, which is a short 
extract from the printed manual provided with the first version. Also look at 
the release notes, which demonstrate how to test the internal calculation 
routines.



Release Notes for Version 0.9 BETA of WinTSS

(these are the release notes that were provided with the first 
version of the program)

The floppy diskette provided with these notes contains the following (please 
copy to a directory on your harddrive).

WINTSS.EXE: The MS-Windows executable. Install in your desktop 
manager (e.g. Program Manager) by creating a new item 
(see Window documentation).

SIM.DAT: Test data from Wildlife Monograph on Line Transect 
Sampling by Burnham, Anderson and Laake, Page 58

DEMO.GIS: Example database. See Section 3 for details on how to 
use BWCC.DLL

BWCC.DLL: WinTSS needs this to display dialog boxes.

WINTSS.HLP: Help file.

1. A short description of the menu items

A more complete manual for the software will be provided with the final 
version once all the items have been finalized. Please provide a list of any 
changes to be made in the terminology used (e.g. the word "critters" will 
obviously be changed in the final version and has only been retained to 
distinguish the beta version from any subsequent final version).

1.1 File

New - Clears the current database and starts a new one.
Open - Retrieve a database from disk.
Save - Save the database to disk.
Save As - Save the database in a particular file.
Print - Print whatever is on the screen.
Quit - Quit.

1.2 Edit



Copy to Clipboard- Copy whatever is on the screen to the clipboard.

1.3 Options

Generation Options

There are two main groups of options here: the Interrupt options and the 
Display options. When enabled, the interrupt options allow you to interrupt a
long calculation and to obtain a status of the current operation. These 
options naturally slow down the computation process, and should be 
disabled if using a slow computer. By default, they are enabled. The Display 
options allow you to decide whether to show generated vegetation and 
animals on the screen. With a very large simulation on a slow computer, 
these options should be disabled to save memory and computation 
resources. By default, they are on.

Color Options

Specify the colour of the background (useful when printing).

1.4 Design

Create/Edit Regions - Draw the regions.
Choose Colors - Choose the appearance of the regions.
Set Scale - Set or change the current scale.
Vegetation - Design the vegetation characteristics for each region.
Critters - Design the animal characteristics for each region.
Transects - Specify the line transect.

1.5 Generate

Vegetation - Generate vegetation.
Groups - Generate animal groups.

1.6 Display

Vegetation - Toggles the display of the generated vegetation on the screen. 

Note: the vegetation cannot be displayed if the Display option for vegetation 
was disabled in the Options menu.



Animals - Toggles the display of the generated groups on the screen. 

Note: the animals cannot be displayed if the Display option for the animals 
was disabled in the Options menu.

Transect - Display the transects.

1.7 Count

Real Data - See below.
Ground count - Perform a ground count along the transect.
Aerial count - Perform an aerial count along the transect.

2. Testing the calculation routines

A means has been provided in this beta test version to test the internal 
routines. The following is a step-by-step explanation of how to perform the 
test:

2.1 Double Click on    the WinTSS icon.

2.2 Under the Count menu, click on Real Data (Optional) 
and then on the Calculate Density popup menu item.

2.3 A dialogue box with the title Fourier Estimate from Real 
Data will appear. Click on the Browse button for a list of 
files. Double click on Sim.dat (provided with the 
programme). The number of data points should be 40.

2.4 Enter "1000" in the Transect Length box, and "65" in the 
Effect Transect Width box. Click on the OK button.

The estimated density in the strip is 0.0004859 +/- 0.0001909, and the 
stopping number used is 1. This data is actually taken from Table 5 in the 
Wildlife Monograph on Line Transect Sampling by Burnham, Anderson 
and Laake, Page 58. There, Burnham et al calculate the density as 0.000486 
+/- 0.000191, and determine the stopping number as m=1. The error was 
calculated assuming that the 40 objects were distributed randomly, which 
clearly is not a valid assumption in some cases.

2.5 Click on the Graph button.

The graph is of the Fourier series estimator of f(x), which Burnham et al 



calculate in Fig.27 on page 59 (they did not do a good job of it!). Burnham et 
al actually produced the data using a half-normal underlying probability 
density function.

This process may be used with any data file containing perperndicular 
distances. The ground count simulation produces a ".cou" file, and the    
aerial simulation produces a ".aco" file. These files contain the perpendicular 
distances of the animals that were sighted, and can be used with other 
analysis packages.

3. Using DEMO.GIS

DEMO.GIS is a fairly complicated database to test how the software performs 
on your system. The following instructions detail how to run a sample 
simulation:

3.1 Start up the WINTSS software. It would be a good idea to disable 
screen savers, and (as with any beta software) save all other 
work.

3.2 Select the Load menu, and select DEMO.GIS to be loaded. If you 
wish, the current vegetation and animal group parameters for 
each region can be viewed by selecting the appropriate Design 
menu option.

3.3 Click on the Options menu, and select Generation options. A 
dialog box will appear. If your computer is limited by memory or 
speed, turn off the Display generated vegetation and Display
generated groups options (there must be no tick mark). These 
options should only be used when testing, or for a once only 
viewing of very large distributions (such as in DEMO.GIS) because
generating onto the screen as well as to the disk may require 
excessive amounts of the system resources.

3.4 Select Generate vegetation in the Generate menu. On a 50 
MHz 486DX, generating the vegetation took about 15 minutes 
(when Display generated vegetation was selected). Click on 
the Status button to see the current status of the computation. 
This procedure generates a 700K disk file called DEMO.V0 
containing the coordinates and radius of every tree. If there is 
already a DEMO.V0 file on the disk, you will be prompted whether
to use that file or to generate another.

3.5 Select Generate groups in the Generate menu. This procedure
generates a disk file called DEMO.A0 containing the coordinates 



of the animals. If there is already a DEMO.A0 file on the disk, you 
will be prompted whether to use that file or to generate another.

3.6 Select Ground count in the Count menu to perform the count.

3.7 To conduct a count using another transect, select Transect in 
the Design menu, click on the Transect button, and draw a 
transect as described earlier. The vegetation and groups need 
not be regenerated, so go straight to the Count menu.

NOTE: To view a distribution file on the disk (e.g. DEMO.V0), do the following:

3.8 Load the DEMO.GIS database.

3.9 Click on the Options menu, and select Generation options. A 
dialog box will appear. Turn on the Display generated 
vegetation and Display generated groups options (there 
must a tick mark in both boxes).

3.10 Select Generate vegetation. When you are asked whether to 
regenerate or use the previous file, select No and the current 
distribution will be plotted on the screen. Note that this can a 
considerable amount of time for a complex distribution.

4. Reporting Errors

Since this is a beta version, there are bound to be problems which escaped 
our own testing. If you encounter any problems, please follow these general 
guidelines:

4.2 Try to reproduce the problem, and provide clear instructions on 
how we can reproduce the problem. If that is not possible, try to 
provide as full a description as possible on what you were doing 
when the problem occurred.

4.3. Please provide us with a list of any aspects of the interface which
are confusing or badly worded. Please also make suggestions for 
what you would like to see in the final online help.

4.4. The easiest way to get in touch with us is through email at 
QUADLING@CS.UMN.EDU, or by snail mail to H.Quadling, c/o A. 
Starfield, 1614 Rosehill Circle, Lauderdale, MN 55108, USA.





Simulation modelling as a laboratory tool

(the following is an extract from the printed manuals which were provided 
with the first version; figures and diagrams are not included here)

1. Simulation as a means of evaluation

    Suppose we have a monitoring technique which we wish to evaluate, i.e., 
we would like to know whether the technique produces useful results. The 
best way of doing this is to try the new method out on a sample area where 
we know the exact population density, and then to compare the actual 
density with replicated census results. Replicating the census is an expensive
and usually impractical approach to the problem. In any case, it is not likely 
that we have access to an area where the exact population density is known.

    Another approach would be to simulate an artificial population on a 
computer, and then to simulate the census exactly as it would be conducted 
in the field. By comparing calculated and actual densities, we could evaluate 
the accuracy of the method. However, we can only fully evaluate a 
monitoring technique by computer simulation if we manage to simulate 
reality perfectly. Since we could never realistically expect to create a perfect 
simulation, we should always be careful in the interpretation of results. The 
closer the simulation experiment is to reality, the easier it is to interpret, and
the less likely it will lead to spurious conclusions. We stress that it is very 
easy to draw spurious conclusions if the simulation experiment is not 
designed properly, i.e, if the assumptions and the objectives are not 
compatible. At the same time, it is also easy to go hopelessly wrong if the 
simulation is too complex. We strive for as simple a simulation as possible, 
with as few assumptions as possible that will get the job done.

    Another common use of computer simulation is to test the robustness of 
various monitoring methods with respect to some factor. For example, a line 
transect sampling model might assume a random homogeneous distribution 
of animals in order to make the mathematics tractable. A simulation model 
might be used to test how robust the statistical model is to departures from 
this rather restrictive assumption. In fact, as far as we can ascertain from the
extensive literature, simulation (not necessarily in the computer medium) is 
the only technique used by researchers to test the robustness of a model. 
The following is an overview.



2. Overview of simulation experiments from the literature

    Several attempts have been made to evaluate monitoring techniques by 
means of simulation. For example, Watson et al7,8 (1969) described a 
serious attempt to simulate problems in East African aerial censusing by 
using actual scale models, but did not make any useful conclusions. A more 
recent simulation experiment conducted by Lake10 (1979) describes the 
placement of wooden stakes in a sagebrush meadow in Utah, in his 
investigation of the line transect sampling method. Lake's data has been 
used to demonstrate the validity of the Fourier series method2. A still more 
recent experiment by Burnham et al (1980) made use of a table top surface 
covered with circles of varying diameters, to simulate the flushing circles of 
animals located at the circle centres. By stretching a nylon string across the 
surface, animals were counted whose flushing circles intersected the string. 
This is an excellent example of how to model the detection problem, in this 
case using the flushing radius concept.

    
    The simulation experiments discussed above have advantages and 
disadvantages over computer simulation experiments. A distinct advantage 
of the Lake stake simulation data over a similar computer simulation is that 
the human eye detects the animals in the Lake simulation, whereas in the 
computer experiment the detection process has to be modelled in some way.
We remind ourselves that the main reason animals are difficult to detect is 
due to limitations of the human visual system (if we had a terminator 
cyborg's eyes, we would be in good shape). This is an important advantage 
that will always justify such experiments. We note however that the simple 
table-top experiment as described by Burnham et al does not have this 
advantage. The advantages of computer simulations are:

1. The cost of non-computer simulation experiments, in terms of 
time and resources, is much greater than that of a computer 
simulation.

2. Non-computer simulations are often plagued by the same 
measurement problems as in the actual census. A computer 
simulated census can be conducted without a single 
measurement error, and all calculations can be done exactly. This
important advantage of the computer simulation makes it an 
ideal laboratory tool to investigate the robustness of various 
monitoring techniques to measurement errors. For example, the 
robustness of various line transect sampling schemes to errors in
the angle and distance measurements can be investigated, 
simply by simulating known errors in the measurements and 



comparing all calculated results with    known values and the 
error-free calculated result. Computer simulations can be used to 
explore the effects of bias in the measurements.

3. Non-computer simulation experiments are usually easy to 
describe, but difficult to replicate. An important advantage of the
computer simulation experiment is the ability of other 
researchers to repeat the same experiment. 

    Probably the first use of computer simulation to study line transect 
sampling estimators was by Gates9 (1969), who used a simulation study to 
explore the effects of varying true population density, line transect length, 
average flush angle, non-independent flushings, and sensitivities of the 
estimators to departures from the assumed detection function. We 
emphasize the word 'assumed', because Gates used an assumed form of the 
detection probability density function f(x) (see 1.14) to generate his 
homogeneous population. Since the simulation experiment was designed to 
explore various aspects of line transect sampling theory which is absolutely 
based on the concept of the detection function, it is difficult to draw 
conclusions from Gates' simulation study. In this case, the problem is that the
simulation experiment is too simplistic, and the structure of the simulation 
experiment is too similar to the structure of the theory of line transect 
sampling for comfort, and it is all too easy to make spurious conclusions.

    Another more recent example of such a use of computer simulation is in 
the Monograph by Burnham et al2, who use computer simulated data in an 
example of the application of the Fourier series method, and to examine the 
bias in the method. In this experiment, perpendicular data is sampled from 
an assumed underlying truncated half-normal density function. Again, the 
simulation model is too simplistic, and not many useful conclusions can be 
made. The only real use of such a simulation model is to provide example 
data in learning how to use the method.

3. Simulation and design

    Before a census can be successfully undertaken, it has to be thoroughly 
planned in advance. It is in this design stage of the census that computer 
simulation is indispensable as a laboratory tool. In this section, we consider 
the value of computer simulation in the design of a census, both as a 
technique and as a discipline.

3.1 Simulation as a 'crutch'



    Computer simulation is an invaluable tool in the designing of a census. 
Suppose that we have clear objectives for the census. How do we use the 
resources at our disposal in order to meet those objectives? (See figure 1.) 
On the one hand we should design the census carefully to meet our goals 
because a census is a huge undertaking that usually cannot be repeated if 
botched. On the other hand, we would also like to know how a census can be
bungled, so that we can avoid doing so. Computer simulation serves as a 
invaluable guide in this design stage, because a computer can explore so 
many different possible scenarios. Specifically, a computer simulation can 
highlight factors that influence the accuracy and reliability of the census. In 
addition to this, simulations can also be used for a practice, or final 'dress 
rehearsal', of the methods to be employed in the census.    

3.2 Simulation as a means of experimentation

    Simulation provides an inexpensive means of experimenting with many 
different techniques or ideas, that otherwise may have been too ambitious or
expensive. Experimenting with a computer simulation model is an excellent 
way to look for patterns and anomalies, which is very often the first step in 
the understanding and interpretation of the results. Through experiment we 
can explore and discover scenarios that we may never have thought of, had 
we not been guided through the process by the simulation. 

    Another consideration emphasizes the relationship between simulation and
experimentation is the total control the experimentalist has over the 
experiment. All measurements can be made with absolute accuracy, and 
there is never any ambiguity in any of the data. This is important since the 
experimentalist can always compare the results with some absolute 'truth'. 
For example, consider an experiment which consists of simulating a ground-
based line transect survey, with vegetation as the factor which inhibits 
detection of the animals. In this case, the calculated density estimator and 
its confidence interval (or any other calculated parameter) can be compared 
with the actual value. If the experiment were to include the effects of 
distance and angular measurement errors (by introducing an element of 
uncertainty in the measurement process), then the experimental results 
could be compared directly with the actual results, since the corresponding 
actual measurements could be calculated exactly in the simulation model. 
For the spatial simulation model which is discussed in this report, the 
location of every animal and every plant and every spatial attribute can be 
determined exactly, with respect to any other point. This level of resolution 
may be much more than is required, but is easy to acquire on modern 
computer systems, and we may be sure that there are never systematic 
measurement errors that could result in spurious conclusions.



    Another aspect of the design of the census which can be explored via 
simulation experiments is the question of which measurements should be 
recorded, and how they should be recorded, in order to meet the stated 
objectives. How data is recorded is an essential part of the design of the 
census. For example, we could conduct experiments in the investigation of 
how to group measurements (in an effort to facilitate the collection of data) 
and still meet our objectives. We could explore how much effort is worth 
expending in the measurements. We could explore the question of resolution,
again always aiming for the objectives of the census that we decide on right 
at the beginning. Simulation is an indispensable tool in our quest to minimize
the effort in the pursuit of the objectives which must be met.    

3.3 Simulation as a means of evaluation

    The use of computer simulation as a procedure of evaluating monitoring 
techniques is not entirely obvious. The only way a statistical monitoring 
technique can be properly evaluated is through controlled experiments. 
However it is possible to evaluate certain aspects of the method being 
considered. An example of such an aspect would be the evaluation of the 
robustness of a method to various factors, such as the robustness of a line 
transect method to inhomogeneously distributed spatial populations. Another
example would the use of computer simulation to determine rough estimates
of the variances of the estimated parameters, as done by Gates9 in his 
computer simulations that we have already discussed.

3.4 Simulation as a discipline

    We could also consider computer simulation as a discipline for defining 
objectives and checking to see whether designs really do meet the stated 
objectives.      This might be the most important role simulation can play. The 
difference between estimating the total population or determining whether 
the population size is in some range might not appear important when one 
talks about a census. Similarly, it might show up major differences between 
these two objectives.



The Estimation of Animal Population Density: a 
Review

(this is an extract from the printed manual which was provided with the first 
version of the software; figures and equations are not included)

1. Introduction

    Monitoring of animal populations is an important activity not only for 
ecological reasons, but also because the proper management of animal 
populations depends on accurate census estimates, or estimates that can be 
interpreted in some meaningful way. Vast sums of money are spent every 
year on monitoring, and there is a large literature on the statistics of the 
problem.

    Several excellent reviews of monitoring methods are available, and this 
chapter serves as a brief review of the statistical results pertinent to our 
study. Most of the material may be found in the book by Seber1 and the 
wildlife Monograph on line transect sampling by Burnham et al2. There are 
also good reviews by Gates3, Eberhardt4 and Kovner et al5.

2. An overview of censusing techniques 

2.1 The single total count

    The most obvious way to determine population density is to survey the 
entire area in an attempt to count all the animals in it. There are however 
many problems associated with this 'brute force' approach. Clearly a serious 
problem is the expense of such an undertaking, particularly if the area in 
which the census is conducted is large. In many cases, the expense that this 
technique entails cannot be justified.

    The accuracy of the total count depends on the visibility of the animals, 
and that is the crux of the problem. The only animals that are included in the



count are the ones that are actually seen, i.e., there is a systematic under 
count. This systematic error is impossible to avoid, and makes all density 
estimates suspect. As a consequence of these possible errors (the magnitude
of which we have no idea), it is difficult to justify a single total count, and 
alternative methods should be explored.

2.2 Total counts in sample areas

    Another way of estimating the population density in an area is to select 
sample areas, and perform a total count in each of the sample areas. One of 
the main reasons for doing this is usually a lack of resources for an 
undertaking as described in the paragraph above, and the possibility of 
doing repeated counts to estimate errors. The choice of size and shape of the
sample areas is governed by many factors, including the specific species 
being counted, the terrain, the vegetation, etc. Usually, the most important 
factor which determines the shape of the sample area is the ease with which 
the sample area can be marked out, and the ease at which the sample area 
can be covered. For aerial surveys, and indeed for most ground based 
censuses, the easiest sample area to navigate is a long thin rectangular 
strip. In this study, we consider our sample areas to be strips. We define a 
'strip' as a rectangular sample area which is oriented in some arbitrary 
fashion in the total area.

    The estimation of population density using sample plots is a well 
established technique which is well covered in the literature. As a simple 
example, we consider a total population of size N which is randomly 
distributed in an area A1. The probability p of finding an animal in the sample
area is    the ratio of the sample area to the total area. In this simple case, the
number n of animals in the sample area pA follows a binomial distribution

These equations can be used to provide a very rough idea of what proportion
of the total area must be covered in order that the variance be within a 
specified tolerance, given a rough lower bound estimate of N. Of course, it is 
seldom (if ever) valid that the population being surveyed is randomly 
distributed, but many of the statistical methods in use today do not insist on 



this assumption, as described later.

    A more ambitious scheme would be stratified random sampling in which 
the total area is divided into different strata. Each stratum would have a 
randomly distributed population, but the strata would not necessarily have 
the same densities. Stratified random sampling is one way of avoiding 
problems with inhomogeneous spatial distributions (Siniff).

2.3  Density estimates from line transects

    One of the most important censusing methods in use today is the line 
transect method, which consists of traversing a straight line transect and 
recording data in a systematic manner.    This can be carried out from the 
ground, or by air.

2.3.1 Detection

    The idea central to the line transect method is that the probability of 
detecting an animal changes with perpendicular distance from the transect. 
The animals are detected in one of two modes: either they are simply seen, 
or they are detected because they flush. The actual mode of detection is 
irrelevant to the theory as reviewed by Burnham et al2, in contrast to other 
authors for whom the detection mode is important1,3. For example, some 
authors describe methods in which the animals that do not flush are not 
counted. Such theories associate a flushing radius with a particular species; 
an observer within the flushing radius of an animal would cause the animal 
to flush and to be seen by the observer, who would then record the 
necessary data.

    The reason that animals are difficult to count is due to limitations of the 
human eye, as well as obstructions such as vegetation, rocky outcrops etc. 
Modelling how obstacles affect sighting probabilities is not difficult, but 
modelling how the physiology of the human eye affects detection is 
practically impossible. In view of this, we realize that it is impossible to 



evaluate monitoring methods fully by means of computer simulations, and 
likewise it is impossible to build these human factors into a statistical model. 
We strive to build a simple model that is useful and that we can interpret 
easily. In the immediate context of line transects, our simple model is based 
on the idea of a detection function, as described later.

    The theory as reviewed below deals with 'objects'. These objects may be 
individual animals, or entire groups as is the case with clustered populations.
If (as usually is the case) the objects being counted in the line transect 
survey are groups, then the location of the object is the centre of mass of the
group, and the number of animals in the group has to be estimated along 
with the distance and angle measurements. There is of course the additional 
question of how the group size affects the detection probability.

2.3.2 Conventions

    We use the standard notation in the line transect theory literature. The 
perpendicular distance of the object to the line transect is denoted by x. The 
relationship between x and the sighting distance r is shown in figure 1, the 
sighting angle being , i.e.,

It is generally assumed in line transect models that these errors are 
negligible, an assumption which may not be valid.    If the error in the angle is
relatively large, then that is where most of the error in x is going to come 
from.

    We denote the length of the transect by L and its half width by w. The 
number of objects counted is denoted by n. The area of the strip is denoted 
by A.

2.3.3 Assumptions underlying the line transect method

    In earlier reviews of the line transect methods, it was often stated that an 
assumption of randomness was necessary, i.e, that the animals are 



homogeneously and isotopically distributed throughout1. In recent years 
however, it has come to be generally accepted that this severely restrictive 
assumption is not necessary, provided that the line transects are randomly 
located2,6. We shall discuss the validity of this and the other assumptions 
later. The following four assumptions are considered important for accurate 
density estimates2:

1. Objects on the actual transect line are seen with certainty.

2. All objects are stationary before they are sighted, and are not 
counted more than once.

3. There are no errors in either angle or distance measurements.

4. All object sightings are statistically independent events.

    A full analysis of how violations of these assumptions affect the density 
estimates has not yet been conducted, nor has there been a satisfactory 
investigation of the assertion that homogeneity is not required.

2.3.4 Detection function g(x) 

    The detection function, usually denoted by g(x), relates the perpendicular 
data xi to the estimators that we are looking for, such as density. Quoting the
definition given in Burnham et al2, the detection function g(x) is defined as 
the conditional probability of observing an object given that the object is 
located at a perpendicular distance x from the line:

We also expect the probability of sighting an object to decrease with 
increasing x, and so we expect g(x) to be a decreasing function of x. 

    Many factors influence the sighting probability of objects, including 
weather and habitat conditions. It would be wrong to suppose that g(x) has 
the same form over the duration of the census. It is fortunate that there are 
analytical methods which are not affected by these factors, such as the 



Fourier series method described later. In addition, it is claimed in the 
literature that g(x) is completely unrelated to the spatial distribution of the 
objects in the strip2.



Using the GIS simulation system: A Simple 
description.

The windows application wintss.exe provides a quick and easy way of 
creating a simple coordinate-free geographical database, on which to 
conduct monitoring experiments.

5.1 A short description

The user enters in a geographical database, by defining regions which are 
bounded by polygons. The user assigns each region the following attributes:

(1) A plant density
(2) A probability density function for the plant radius distribution.
(3) A group density
(4) A probability density function for the group size distribution.
(5) Various parameters which determine the minimum distance between 

groups, how the groups are distributed spatially, and how the 
individual animals are scattered spatially within the group.

The scale is also set by drawing a line segment, and then specifying the 
length of the line in any units. All calculations such as areas and densities 
will calculated in terms of those units.

A single transect which has a beginning and an end and a width is also 
entered.

The user is then able to perform either a ground count or an aerial count. 
The densities are calculated using the Fourier series method (described in 
Chapter 1), and all the information neccessary to compare the estimated and
observed parameters with the actual parameters is provided.

It is also possible to use the built-in Fourier series routines to calculate 
densities and approximate errors on real data (perpendicular sighting 
distiances from the base line).

5.2 How the animals are counted.

For the ground count:



It is assumed that an animal has a certain fixed probability of being detected 
if it is behind a plant. If the animal is behind n plants, then the probability is 
raised to the nth power. There is another fixed probability of the animal being
observed even if it is not obstructed by any plants. These probabilities are 
specified by the user before conducting the count. This is the simplest way to
model how the probability of detecting an animal falls off with the 
perpendicular distance from the transect baseline. It should be kept in mind 
that this is a model, and that these probabilities along with the vegetation 
cover chosen should be used to simulate the problems associated with a 
census in a simple way.

According to these probabilities, if the animal is detected, the perpendicular 
sighting distance is recorded. The density is estimated using the Fourier 
series method, and a 95% confidence interval is also calculated. The 
confidence interval is based on a Poisson distribution (which is not a good 
assumption, especially for groups) and should not be taken as an accurate 
figure, but merely as a guide to the errors involved.

For the aerial count:

The aerial count is quite similar to the ground count, except that in this case 
there is a fixed probability of the animal being detected if it is under a plant. 
Again, using two probabilities to determine whether or not the animal is 
detected is the simplest way of modelling the situation of how some animals 
are missed.

In both cases, the estimated underlying probability density function f(x) (the 
'detection' or 'sighting' function) can be displayed.
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